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Introduction
Ireland Address Data Information
Dataset Code:
Approximate Data
Size:
Data Source:
Update
Frequency:

Expiry:

IRL
45MB
Experian / GeoDirectory
Quarterly
The quarterly data release dates are:


January



April



July



October

Data files will expire 13 months after creation. For example, January data will expire in February
of the following year.
Ensure every data update is applied promptly, otherwise the data may expire and the product will
become unusable.

List Of Available Data Files
File
Extension

File Type

Comment

.dts

Dataset

Main address data.

.zlx

Single Line Index
File

Indexing data for use with Single Line searching.

.tpx

Typedown Index
File

Indexing data for use with Typedown searching.

.dap

DataPlus Set

DataPlus data. See page 10 for more information about the available DataPlus
sets.
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About This Data
This chapter provides detailed information about the IRL dataset.

Area Covered
The IRL dataset covers to premises level all counties under the administration of the Republic of Ireland.

Address Elements
The following address elements are stored within the IRL data files.
Address Element

Example

Element Code

Building Number

52

P11

Building Name

Rosebank

P12

Sub Building Name

Apartment

P21

Sub Building Number

1

P22

Secondary Thoroughfare
Dublin Road
Secondary Thoroughfare Name
Dublin
Secondary Thoroughfare Descriptor Road

S11
S111
S112

Gaelic Secondary Thoroughfare

Bóthar Átha Cliath

S12

Primary Thoroughfare
Primary Thoroughfare Name
Primary Thoroughfare Descriptor

Francis Street
Francis
Street

S21
S211
S212

Gaelic Primary Thoroughfare

Sráid San Proinsias S22

Building Group
Building Group Name
Building Group Descriptor

Saint Canice's Court S31
Saint Canice’s
S311
Court
S312

Gaelic Building Group

Cúirt Chainnigh

S32

County **

Co Sligo

L11

County Prefix

Co

L111

County Name

Sligo

L112

PNR County **

Co Cork

L12

PNR County Prefix

Co

L121

PNR County Name

Cork

L122

Gaelic County **

Sligeach

L13

Gaelic PNR County **

Corcaigh

L14

Posttown

Portlaoise

L21

Resident Preferred Posttown

†

L22

Gaelic Posttown

Port Laoise

L23
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Address Element

Example

Element Code

Gaelic Resident Preferred Posttown †

L24

Secondary Locality

Castletroy

L31

Gaelic Secondary Locality

Caladh An Treoigh

L32

Primary Locality

Ballinla

L41

Gaelic Primary Locality

Béal An Átha

L42

Country *

Ireland

X11

Two character ISO country code *

IE

X12

Three character ISO country code *

IRL

X13

* Elements that only appear in the address if their position is fixed.
** Only one of the L11 or L12 elements (and only one of the corresponding Gaelic L13 or L14 elements) will be populated,
depending on whether the County name is the same as the county town. See "Postal Code Structure" on page 7.
† This element is the same as L21 (L23 for Gaelic addresses) unless the resident prefers the posttown to be dropped, in which
case it is blank.
Townland is not an address element in the IRL data. Instead, townlands are aliases of the Primary Locality element; see
"Townlands" on page 7.

Address Element Definitions
Localities
The Ireland dataset contains primary and secondary locality information.



The primary locality is usually the village that is the nearest postally-correct delivery point to the search address.
The secondary locality is usually the next closest village or small town to the address that is a postally-correct delivery
point.

Secondary localities are usually larger in size than primary localities.
Examples of addresses that include both primary and secondary localities are:
Jennings Plant Hire
Carla House
Feagh
Tiermaclane
ENNIS
Co Clare
1 The Terrace
Nadd
Banteer
Co Cork

In this address, Feagh is the primary locality and Tiermaclane is the secondary
locality.

In this address, Nadd is the primary locality and Banteer is the secondary locality.

The Ireland dataset also contains posttown and townland information.
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Posttowns
The posttown is the town or postal district associated with the premises for postal delivery purposes.
If the posttown is the same as the county town, the County is not returned in any of the standard forms of address (see
"Forms Of Address" on page 7). The PNR County is returned in the Resident Preferred forms of address if the posttown is
dropped from the final address.
For example, if an address is in "Cork, Co Cork", "Co Cork" will be dropped from the final address. If you want to ensure that
the County is always returned, you should fix both the County element and the PNR County element to your layout, since
only one will be populated. Refer to your product documentation for information about fixing elements.

Townlands
The townland is the lowest-level officially defined geographical unit of land.
Townlands are not elements in the data; they are stored as aliases in the Primary Locality element. They will only be
returned in addresses if a layout based on a Resident Preferred form of address is being used (see "Forms Of Address" on
page 7) and the townland was included in the input address.

Postal Code Structure
Postal codes are not currently used in Ireland for mail sorting and routing.
Dublin is divided up into numbered areas, for example Dublin 1. These area numbers run from 1 to 24, with the exception
of 19, 21, and 23 which do not exist. Odd numbers represent districts North of the river Liffey and even numbers represent
areas to the South of the river. There is also an area called Dublin 6W.
These areas can be abbreviated in Typedown and Single Line searches as, for example, D1 and D6W.

Diacritics
The Gaelic language address elements often contain diacritic characters. These entries also have aliases stripped of the
diacritics, so your search results will be identical whether or not you include diacritic characters in your search criteria. For
example, A will be matched to Á, o will be matched to ó, etc.
You can choose whether to return output addresses in a format which includes diacritics by enabling or disabling the
Flatten Diacritics checkbox on the Pro API Configuration Editor, or the OEMCharacterSet and FlattenDiacritics settings
in the configuration files. For more information refer to your product documentation.

Forms of Address
Forms of address are referred to as Country Views in Pro API version 6 and earlier.
There are four forms of address stored in the IRL data files:


GeoDirectory (English)



Resident Preferred (English)



GeoDirectory (Gaelic)



Resident Preferred (Gaelic)
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The Gaelic versions of the forms of address are alternative language versions which work in the same way as the English
forms. On occasions when a Gaelic form of address is selected and no Gaelic equivalent exists for an address element in
the data, the English version will be returned.
The form of address determines which address elements are used in the returned address. County, Posttown, Secondary
Locality and Primary Locality are examples of address elements which vary according to the form of address selected.

GeoDirectory
The format of an Irish address depends on whether there is a Building Group in the returned address. The official
GeoDirectory (An Post) address is made up from the following elements:
Address with Building Group

Address without Building Group

[Personal Name]*

[Personal Name]*

[Department]*

[Department]*

[Organisation]*

[Organisation]*

[PO Box]*

[PO Box]*

[Sub Building Name/Num][Building Name]

[Sub Building Name/Num][Building Name]

[Building Number][Building Group]

[Building Number][Primary Thoroughfare]

[Primary Thoroughfare]

[Secondary Thoroughfare]

[Secondary Thoroughfare]

[Locality]

[Locality]

[Secondary Locality]

[Secondary Locality]

[POSTTOWN]

[POSTTOWN]

[County]

[County]

* Denotes address lines containing elements not included in the IRL dataset.
Note that the County name is not required when it is the same as the Posttown. Many addresses in rural areas have no
thoroughfare or premises information.

Resident Preferred
In Ireland, the way residents prefer to write their addresses commonly differs from the official GeoDirectory format. This
occurs for one of the following reasons:


Unexpected Posttown



Dublin Periphery



Bordering Localities
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Unexpected Posttown
In rural areas the posttown for an address can be a significant distance away from the actual premises. In these cases,
and especially when the posttown is in another county, a resident would not expect the posttown to be included in the
address. Pro API does not return these unexpected posttown when a Resident Preferred form of address is selected.
For example, the unexpected posttown "ENNISCORTHY" is not present in this address when a Resident Preferred form is
selected:
Language

GeoDirectory Form Resident Preferred Form

English

Coolnagree
Adamstown
ENNISCORTHY
Co Wexford

Coolnagree
Adamstown
Co Wexford

Gaelic

Cúil na Graí
Baile Adáim
INIS CÓRTHAIDH
Loch Garman

Cúil na Graí
Baile Adáim
Loch Garman

Dublin Periphery
Resident Preferred forms of address return the county rather than the postal district number for localities on the Dublin
periphery.
Inner city addresses always return a Dublin postal district number.
For example, the Dublin district number in this address is replaced by "Co Dublin":
Language

GeoDirectory Form

Resident Preferred Form

English

Barnados
7 Main Street
Clondalkin
DUBLIN 22

Barnados
7 Main Street
Clondalkin
Co Dublin

Gaelic

Barnados
7 An tSráid Mhór
Cluain Dolcáin
BHAILE ÁTHA CLIATH 22

Barnados
7 An tSráid Mhór
Cluain Dolcáin
Baile Átha Cliath

Bordering Localities
Premises are sometimes located on or close to the border of two (or more) localities. In these cases, residents may not
want to use the locality where the address is "officially" located, but instead prefer to use the neighboring primary or
secondary locality, or even the neighboring county name. The Resident Preferred forms of address will return a
bordering locality instead of the official one only when the bordering locality was included in the input address.
The English example below assumes the bordering primary locality "Montpelier" was included in the input address. The
GeoDirectory forms revert to the "official" locality, but the Resident Preferred forms retain it as a valid bordering locality:
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GeoDirectory Form Resident Preferred Form
English

Carob Cottage
Derryhasna

Carob Cottage
Montpelier

Co Limerick

Co Limerick

The Gaelic example below assumes the bordering primary locality "Baile an Locha" was included in the input address. The
GeoDirectory forms revert to the "official" locality, but the Resident Preferred forms retain it as a valid bordering locality:
GeoDirectory Form Resident Preferred Form
Gaelic

Amber Hill
An Eaglais
An Carraigín

Amber Hill
Baile an Locha
An Carraigín
Cill Chainnigh

About DataPlus Information
You can configure your Experian Data Quality products to use the DataPlus sets that are available for IRL data. Please
refer to the relevant section of the product documentation for information on configuring Experian Data Quality products to
return DataPlus information.
Each DataPlus set is divided into one or more items. Experian Data Quality products can be configured to return these
items via the Configuration Editor (using the element name) or the configuration file (using the code name). This section
details the DataPlus sets currently available for IRL address data.

DataPlus Sets for IRL Address Data
The following DataPlus sets are available with IRL Address Data:


Ireland Address



Ireland Postaim



Ireland Mosaic

The supplier for Address DataPlus is GeoDirectory, a collaboration between An Post and Ordnance Survey Ireland (OSI).
The supplier for Postaim data is Experian. Mosaic DataPlus is supplied primarily from the Census.
A separate license key is required to use IRL MOSAIC DataPlus. When you install any data for the first time, you are
prompted to enter the license key for each dataset that you want to install. For more information about licenses, see the
License Manager section of your product manual. To obtain a license key, contact your Experian Data Quality account
manager.
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Ireland Address
Identifier: IRLADD
The IRLADD DataPlus set provides additional information about some elements of the returned address.
The IRLADD DataPlus set contains the following elements:
Element

Code

Description

Building Group BGrTypeName Building group type name, for example, shopping centre, or educational campus. The
data has limited coverage; this field is not populated for most addresses.
Type Name

Ireland Postaim
Identifier: IRLPOS
Postaim is an An Post service that offers discount on bulk direct mailings when the customer does the presorting. There
are two levels of presorting: Postaim 2 and Postaim 3. The Postaim DataPlus set returns these values.
The Postaim DataPlus set also returns a value for the postal district hub.
The Postal District Hub is not a feature of the An Post Postaim bulk mailing discount and therefore should not be used
for presorting mail for Postaim discounts.
The IRLPOS DataPlus set contains the following elements:
Element

Code

Description

Postaim 2

P2

Postaim 2 Locality. This is a more general postal location, for example, Laois. The Postaim 2
presorting discount is offered on mailings of 2,001 - 10,000.

Postaim 3

P3

Postaim 3 Locality. This is a more specific postal location, for example, Tipperary Town. The
Postaim 3 presorting discount is offered on mailings greater than 10,000.

Via Hub

HUB

Postal Distribution Hub. This acts as a central distribution point for the surrounding Postal
Districts. There are four Postal Distribution Hubs in Ireland: Athlone, Cork, Dublin and
Portlaoise.
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Ireland Mosaic
Identifier: IRLMOS
The IRLMOS DataPlus set returns IRL MOSAIC demographic data relevant to a given address.
IRL MOSAIC information is obtained primarily from the Census, but other (anonymous) third party data sources are also
used. The data enables marketeers to predict the type of people living at a given address. Each address in Ireland has
been classified into one of 40 MOSAIC types and 11 MOSAIC groups.
There are just under 20,000 MOSAIC Areas which are derived from address clusters throughout Ireland. Each one equates
to between 40 and 75 households.
IRL MOSAIC only includes data for The Republic of Ireland. For more information about IRL MOSAIC, please visit the IRL
MOSAIC Web site:
http://www.experianmarketing.ie/
http://www.experian.ie/micromarketing.html
Updates are supplied to Experian Data Quality annually but only account for changes in GeoDirectory data. Historically, the
MOSAIC data is only re-clustered after each Census (every five years). In the future, given the increase in sources of data
used to create the MOSAIC classification, updates may be more frequent.
The IRLMOS DataPlus set contains the following elements:
Element

Code

Description

MOSAIC Group

GrpCode

MOSAIC Group Code

MOSAIC Group Name GrpName

MOSAIC Group Name

MOSAIC Type

TypeCode

MOSAIC Type Code

MOSAIC Type Name

TypeName MOSAIC Type Name

MOSAIC Area

AreaCode
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Using This Data
This chapter provides search tips and other product-specific information when using Pro API, Pro Web, or Batch API.
These searches are accurate at the time of data release. However, search results may differ depending on the data
release you are using.

With Pro API
Ireland Address Layouts
Forms of Address
The Ireland dataset includes several forms of address, as described on page 7. The default layout will return addresses in
the default form of address. If you want to return addresses in a different form, you must set up additional address layouts.
Forms of address are referred to as Country Views in Pro API version 6 and earlier.

Adding Layouts
Additional layouts are set up using the Configuration Editor. Once saved, new layouts can be activated after you restart
Pro API. You can set up layouts in the Configuration Editor with the following steps:
1. In the Configuration Editor Layout Manager, double-click on Ireland. This expands the list of layouts that are set up.
2. Click on the New layout button on the toolbar. Alternatively, from the Layout menu, click New, or right-click Ireland and
choose New from the menu.
A dialog opens listing the available forms of address.
3. Select the form of address you want to add and click OK. The new layout is added to the bottom of the layout list.
4. Rename the new layout. For example, if you added a layout based on one of the Gaelic language forms, you might
rename the layout "Gaelic". You can rename the layout at any time by right-clicking it in the list and selecting Rename
from the menu.
5. You can assign a hotkey for the new layout. When Pro API is minimized, using a layout-specific hotkey will pop
up the program and automatically select that layout.
To assign a hotkey, click on the Hotkey field in the Layout Properties pane and press the keys you want to assign. For
example, if you have added a Gaelic layout, click in the Hotkey field and press CTRL + G. When Pro API is minimized,
this hotkey pops up Pro API in your Gaelic layout.
It is recommended that you do not choose a hotkey that is already in use by Pro API(see the "Available Keystrokes"
topic in the Pro API Help). You should also avoid common hotkeys, for example, CTRL + A, which in many
Windows applications means "Select All".
For more information about hotkeys, see the Configuration Editor Help.
6. Save the changes you have made in Configuration Editor by clicking the Save button in the toolbar, or clicking Save
from the File menu, or pressing CTRL + S.
7. Close the Configuration Editor. The changes you have made will not take effect until you have closed and restarted Pro
API.
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Changing Layouts
You can change the current layout in Pro API by clicking Select Layout... from the View menu or pressing CTRL + L. The
Select Layout dialog opens. Choose the required layout from the list.
You can change the layout at any stage of your search. To see a final returned address in a different layout, click Select
Layout... from the View menu, or press CTRL + L, and click the layout.
If you drag the Select Layout dialog to the side of Pro API, you can preview the differences to the returned address as
you browse different layouts.

Search Examples: Typedown

The following table provides a list of these example search types:


Full address known



Primary and secondary locality not known



Gaelic language address known

Full address known

1. Enter the locality, knocknacarra, and press Enter.
2. Enter the first few letters of the street name, for, and press Enter. In this example for is
enough to uniquely identify Forest Hills as there are no other streets beginning "For...".
3. Enter the premises number, 8, and press Enter.
The correct address is returned:
8 Forest Hills
Knocknacarra
Co Galway

Primary and
secondary locality
not known

1. Enter the county, co kildare, and press Enter.
2. Enter the first few letters of the street name, shed, and press Enter.
3. Enter the premises number, 632, and press Enter.
The correct address is returned:
632 Shed Road
Levitstown
Maganey
Co Kildare
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Search type
Enter the locality, inis, and press Enter.

address known

Enter the street name, coill na gcoll, and press Enter. Note that the street name is displayed
in both English and Gaelic in the picklist, whereas the locality is only displayed in English:

3. Enter the premises number, 3, and press Enter.
The correct address is returned, according to the layout selected. The default layout will return
addresses in the Resident Preferred (English) form of address:
Ennis
Co Clare

Search Examples: Single Line

The following table provides a list of these example search types:


Full address known



Only street name known



Gaelic language address known



Character missing from address



Address contains spelling mistake



Incomplete address element (partial)



Incomplete address element (tagged)

Full address
known

Enter the premises details and the street name followed by the locality:
apartment 7, main st,borrisokane
The correct address is returned:
Apartment 7
Main Street
Borrisokane
Co Tipperary

Only street name
known

If only the street name is known, entering the street will return a picklist from which the correct
one can be selected. Pro API can handle abbreviated street descriptors such as st, rd, ave or cl.
Enter church ave to view a list of every street called "Church Avenue" in the country.
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Gaelic language
address known

In this example you are searching on a full Gaelic language address:
11 an fhaiche,inis,an clar
The correct address is returned, according to the layout selected. The default layout will return
addresses in the Resident Preferred (English) form of address:
11 The Green
Lifford Road
Ennis
Co Clare

Character missing
from address

If one or more characters are missing from the address the unknown characters can be replaced
with a question mark.
Enter 5?unters ave,fi?house and the correct address is returned:
5 Hunters Avenue
Hunters Wood
Firhouse
DUBLIN 24

Address contains
spelling mistake

Entering an address that contains one or more spelling errors can still return the correct address.
Entering 196 few vale,shankhill will still return the correct address:
196 New Vale
Shankill
Co Dublin

Incomplete
address element
(partial)

If you only have partial address information, you can replace the remainder of an address element
with an asterisk.
Entering chapel*, co cork will display a picklist of streets beginning "Chapel" in County Cork.

Incomplete
address element
(tagged)

Sometimes it is helpful to tag a part of the search string to let Pro API know which part of the
address it is. For a list of available search constraints, see Search Constraints below.
Searching on bally*@s,carlow, will display a picklist of streets that begin with "Bally..." in Carlow.

Search Constraints
The following search constraints can be used to restrict searches when using the Single Line search engine in Pro API or
Batch API Interactive.
Constraint Elements Restricted to

Example

@C

County

dublin@c

@T

Posttown

10 main street,cork@t

@S

Secondary Thoroughfare, Primary Thoroughfare

abbey*@s,clonmel

@P

Building Name/Number, Sub Building Name/Number garden*@p,wicklow

With Pro Web
The Ireland dataset contains several forms of address, as described on page 77. Pro Web integrations can be configured
to use address elements relating to any form of address. Refer to your Pro Web documentation for configuration
instructions.
An example of how forms of address can be configured with address layouts in Pro API is provided on page 13.
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Scenarios
The following table indicates the relevant search examples for each Pro Web scenario and search engine that supports
IRL address data.
Scenario

Search engine

For search examples, see:

Address Capture Single Line Hierarchical Single Line search examples on page 15.
on the Intranet
Address Capture Single Line Flattened
on the Web

Single Line search examples on page 15.

Address Capture Single Line Flattened

Single Line search examples on page 15.

Single Line

Single Line Hierarchical Single Line search examples on page 15.

Standard

Typedown
Typedown examples on page 14.
Single Line Hierarchical Single Line search examples on page 15.

ActiveX Control

Typedown
Typedown examples on page 14.
Single Line Hierarchical Single Line search examples on page 15.
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With Batch API
If you are using Batch API to clean your database against more than one dataset, DataPlus information cannot be
configured.
This section details the information relevant to using Batch API with Ireland address data.

Licenses
An Post require the use of GeoDirectory data to be charged on a per-record basis when using Batch API. Your license for
the IRL dataset will be a metered license. 'Clicks' are counted against the meter when you process your database, and
these must be activated before you can output results from Batch API. Refer to your Batch API documentation for more
information about metered licenses, activating clicks and increasing the clicks available on your meter.

Forms of Address
The Ireland dataset contains several forms of address as described on page 7. You can configure Batch API Standalone
to return addresses using a particular form during session configuration. Refer to your Batch API documentation for more
detailed instructions.
Batch API integrations can be configured to use address elements relating to any form of address. Refer to your product
documentation for address layout configuration instructions.

Dataset-Specific Input Field Types
When you are configuring a Batch API session, you can specify the address elements which are contained in your input
fields. This can speed up the cleaning process as Batch API does not have to work out which address element is contained
within a field.
There are no dataset-specific input field types defined for Ireland data. Only the generic input fields (Organization, Place,
Country, etc.) are available.

Dataset-Specific Filters
Batch API provides a number of default filters to use when viewing, exporting or committing the results of a session.
When using the Ireland dataset, you can use the Ireland Chargeable Records filter to export or commit only those records
which you will be charged for under the terms of you’re an Post license. See "Licenses" (above) for more information
about these terms.

Dataset-Specific Information Bits
IRL-Specific Information Bits
When using IRL data a selection of dataset-specific information bits can be returned.




For Standalone users, IRL-specific information bits are returned as the first 8 digits of the 16-digit extended match
result as displayed in Interactive.
For API users, these are returned by the function QABatchWV_GetMatchInfo as parameter rlCountryInfo1, and from the
function QABatchWV_Clean in the parameter rsReturnCode from the 13th to 20th characters. Refer to the Batch API
manual for further information about these functions.

The following table provides a full list of IRL-specific information bits that can be returned.
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Information Bit

Description

10000000

English Primary Locality added that was not supplied in the input address

20000000

Gaelic Primary Locality added that was not supplied in the input address

40000000

English Secondary Locality added that was not supplied in the input address

80000000

Gaelic Secondary Locality added that was not supplied in the input address

01000000

Street retained from the input address that is not in the data

02000000

Street added that was not supplied in the input address

00100000

Match to bordering locality

00200000

Match to bordering Dublin district number

00400000

Wrong Dublin district number supplied

00800000

Match to bordering county

00020000

Posttown added

00001000

Gaelic Primary Thoroughfare available

00002000

Gaelic Secondary Thoroughfare available

00004000

Gaelic Primary Locality available

00008000

Gaelic Secondary Locality available

00000100

English Posttown has been removed

00000200

Gaelic Posttown has been removed

00000400

English Resident Preferred Posttown has been removed

00000800

Gaelic Resident Preferred Posttown has been removed
Non-trivial change applied as a result of referencing An Post data

Search Examples: Batch API Interactive
For information about the best methods for searching on Ireland addresses using Batch API Interactive please refer to
Single Line search examples on page 15 and Typedown search examples on page 14.
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